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Soliciting Reader Contributions to 

Software Tutorials 

Abstract 

Online software tutorials help a wide range of users acquire skills with complex software, 

but are not always easy to follow. For example, a tutorial might target users with a high 

skill level, or it might contain errors and omissions. Prior work has shown that user 

contributions, such as user comments, can add value to a tutorial. Building on this prior 

work, we investigate an approach to soliciting structured tutorial enhancements from 

tutorial readers. We illustrate this approach through a prototype called Antorial, and 

evaluate its impact on reader contributions through a multi-session evaluation with 13 

participants. Our findings suggest that structuring tutorial contributions has positive 

impacts on both the number and type of reader contributions. Our findings also point to 

design considerations for systems that aim to support community-based tutorial refinement, 

and suggest promising directions for future research. 
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Chapter 1 – Introduction 

Introduction 

When learning a new complex application, or seeking to improve their skills, users 

frequently consult online software tutorials [12]. While there is no shortage of such 

resources available, applying the workflows as described is not always straightforward. 

First, a given tutorial is typically written from a single perspective in terms of software 

knowledge and version, which is not always adequate for the tutorial’s potentially wide 

and diverse user base. For example, users of varying levels of software expertise sometimes 

desire more explanation than the tutorial author has provided and can have difficulty 

adapting the instructions to their particular versions of the software [22]. In addition, like 

many forms of user-generated content, online tutorials also vary in quality [27], and can 

contain errors and omissions [22]. 

One way that the tutorial community has attempted to address these challenges is through 

comment sections, where, in addition to expressing their appreciation to the author, tutorial 

readers post a range of tips, suggestions and corrections to the tutorial [22]. Prior work has 
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shown that categorizing and placing these user comments next to a tutorial improves their 

perceived utility [3]. We can see that people are willing to help improve documents and 

that these contributions have the potential of being beneficial, but we know little about how 

soliciting these contributions in the context of software tutorials can impact the quantity 

and type of submissions. 

In this thesis, we describe how we approach the problem of developing and evaluating an 

interface which allows readers to contribute content to software tutorials. The goal is to 

gain insight into how interface design can impact the manner in which community 

members contribute to online software tutorials.  

1.1. Research Questions 

While exploring potential interfaces, and creating and evaluating our system for supporting 

community contributions, Antorial, we had the following research questions: 

1) How can community contributions be integrated into software tutorials in such a 

way as to respect tutorial authors’ reasons for posting initial tutorials? Other readers 

have information that everyone can benefit from [22], and we can possibly 

emphasize the role of these contributions through their presentation. However, 

authors have personal reasons for making their tutorials available [30], and so, we 

explore designs that leave the originally authored content intact. 

2) How does the manner in which the interface solicits contributions impact the 

frequency and content of submissions? Prior work has shown that promoting, 

tagging, and placing user comments next to a tutorial improves their perceived 

utility [3], but we do not know how their presentation affects comment elicitation. 
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1.2. Methodology and Approach 

We approached our research questions by i) exploring different interfaces using low-

fidelity prototypes to help determine what features would be needed, ii) implementing a 

software prototype, Antorial, and iii) evaluating Antorial through a multi-session 

evaluation. What follows is a summary of each of these thesis components. 

1.2.1. Prototyping and System Development 

Building on prior work, we focus on soliciting tutorial enhancements from the tutorial user 

community. There are many potential interface designs we could use, and to help prevent 

us from arriving at a local maximum [16] while exploring solutions, we used sketching as 

a tool to consider as many possible solutions as we could [4,17]. While implementing our 

chosen prototype, we also came back to paper prototyping when refining certain 

interactions, and to gather informal feedback. 

Using our sketches, we decided on a direction, and implemented the chosen interface as a 

web application that we call Antorial (Chapter 3.2). With Antorial, tutorial readers are able 

to submit categorized notes to the tutorial, and associate them to a step. We iteratively 

improved the system using informal feedback and through a pilot study (Chapter 3.3). 

1.2.2. Multi-Session Evaluation 

To evaluate Antorial and to see how community contributions are impacted by their 

placement and organization (our second research question), we conducted a multi-session 

evaluation among 13 expert Photoshop users. The participants were asked to improve four 

different Photoshop tutorials on their own time, using Antorial for half the tutorials, and a 

baseline commenting system for the other half (Chapter 4). 
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Our results indicate that participants contributed more with Antorial than with the baseline 

system. Our results also indicate that Antorial’s scaffolding might have positive impacts 

on the type of notes contributed by our study participants. Finally, our discussion of these 

results highlights the importance of considering the sense of community associated with a 

tutorial and the perceived social costs of contributing. 

1.3. Contributions 

In summary, our work contributes the following: 

1) We present and illustrate a model for community tutorial enhancement via 

structured user contributions specific to tutorial content. 

2) We present results from a multi-session evaluation demonstrating the impact of 

our model on tutorial contributions. 

3) We derive important design considerations for systems supporting community-

driven tutorial enhancement. 

The remainder of this thesis is organized in four chapters: Chapter 2 summarizes prior work 

related to this thesis, Chapter 3 describes our design goals, the system that we implemented 

and evaluated (Antorial), and an initial pilot study, Chapter 4 describes the multi-session 

evaluation as well as results and a discussion arising from the study, and Chapter 5 

concludes the thesis. 
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Chapter 2 – Related Work 

Related Work 

Our related work covers four areas: previous approaches to improving software tutorials, 

including support for tutorial authoring; prior work on soliciting and structuring 

community software knowledge; work on collaborative document refinement; and work 

relating to annotation systems for other educational material. 

2.1. Improving Software Tutorials and Authoring 

Given the ubiquitous role of tutorials in supporting skill acquisition and development with 

complex software, there is a rich history of research on improving their utility. Common 

avenues explored include the design of novel, engaging tutorial formats (e.g., 

[10,14,18,25,26]), and ways to improve the degree of integration between a tutorial and the 

target application (e.g., [19,29,31]). Others have acknowledged the workload associated 
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with authoring an effective tutorial, proposing a range of semi-automated or 

demonstration-based approaches (e.g., [7,15,18]) to help ease this burden.  

Most directly relevant to our work are approaches to tutorial authoring and enhancement 

that promote or facilitate post-hoc contributions from either paid crowd workers or a 

tutorial’s user community. For example, to enable tutorial users to more easily navigate a 

video tutorial’s contents, prior work has used crowd workers to help segment it into 

individual steps [20]. Like our approach, others have explored systems that capture and/or 

leverage the perspectives of other tutorial users. One example is allowing users to upload 

their own demonstrations of a tutorial as a complement to the original [23]. An evaluation 

showed that having multiple demonstrations available reduced users’ frustration when 

completing a tutorial [23]. Others have enhanced tutorials via tagged user comments, 

“pinned” at the side of the tutorial [3]. Their evaluation demonstrated that having 

comments organized in this manner (in their case by the paper authors) improved users’ 

subjective impressions of the utility of these comments [3]. 

2.2. Eliciting and Sharing Software Knowledge 

Central to our approach is the tenet that users are willing to contribute their software 

knowledge, in our case, as a means of improving a software tutorial. This assumption is 

supported by a number of prior studies illustrating people’s desire and willingness to share 

their knowledge of and experience with complex software. For example, studies have 

shown that one of the motivations for authoring a tutorial in the first place is a desire to 

showcase interesting workflows [30]. Prior work indicates that users are already 

appropriating tutorial comment sections as a way of contributing additional material to 

complement the main tutorial (e.g., corrections and tips) [22]. Studies of application- or 
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web-page-specific Q&A systems (e.g., [8,28]) have shown that users are willing and able 

to answer others’ application-specific questions.  

We also build on findings demonstrating the value in structuring these community 

software-related contributions. Examples of ways to structure contributions that others 

have proposed and explored include attaching Q&As directly to interface elements (e.g., 

[8,28]), categorizing tutorial comments according to their type and placing them next to 

the area of the tutorial that they reference [3], and projecting tweets about new and 

interesting tutorials and workflows onto the interface elements that they reference [11].  

The value of structured and/or integrated community contributions has also been 

demonstrated in a number of domains outside of learning complex software. For example, 

allowing learners to anchor their comments to an online educational video’s timeline led 

to a greater sense of social presence and likelihood of contribution [24]. Structuring 

comments through categorization has been shown to increase engagement with online 

discussions [13] and productivity in collaborative visual analytics tasks [32]. 

2.3. Other Models of Collaborative Document Refinement 

The approach to tutorial enhancement that we investigate in this thesis can be viewed as a 

form of collaborative document refinement that harnesses the wisdom of the community. 

A number of models of collaborative document refinement have been proposed and/or 

extensively studied in the literature. One common approach is the Wiki model, where a 

group of authors collectively refines a document, a popular instance of which is Wikipedia. 

The Wiki model generally assumes a single “best” document that the community works to 

achieve collectively. Within this model, community members take on a number of 
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(evolving) roles to help ensure that articles are held to community standards (e.g., [2,21]). 

Edits are also tracked to enable documents to revert to prior states in the case that this 

collective action is not seen to produce improvements.  

Other models of collaborative authoring rely on a lead author, or small set of lead authors, 

to evolve a document, with collaborators providing feedback on ways to enhance it. Prior 

work in this space has explored a number of supporting technologies, including obtaining 

quick access to feedback and/or suggestions using paid crowd workers [1] and structuring 

collaborator comments to enable authors to process them more effectively and efficiently 

[36]. 

2.4. Annotation Systems for Other Educational Material 

In this thesis, we use community-submitted annotations as our model for improving 

tutorials. Other work has also looked at annotating documents for different purposes. For 

example, researchers have created systems letting students annotate textbooks or other 

classroom material for themselves, their peers, or the instructor [6,34,35,37]. In these 

examples, students gained a greater appreciation of the material being taught and there 

were instances of students helping other students, mirroring our hope that tutorial readers 

will help other readers. 

One difference between this thesis and this related work lies in the motivation of users. 

Like a Wiki model, our current system doesn’t offer any material compensation for 

contributing, so contributors will have to find some other source of motivation, such as 

forming personal goals or applying personal standards to tutorials [2,33]. On the other hand, 

when annotating educational material, students were motivated to use the systems to do 
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well in their course, and so they can receive a better grade. However, it is encouraging to 

note that researchers have observed the students using the systems voluntarily, even when 

not required [6,37]. 

2.5. Summary 

Previous work has shown the importance of tutorials in learning and how users are able 

and willing to contribute their own knowledge in the improvement of documents. We have 

described prior systems which allow the user to submit additional content to documents. 

We extend this body of work by focusing specifically on an approach to soliciting tutorial 

enhancements, and evaluate its impact on user contributions. Additionally, we have seen 

that people are motivated to contribute to Wikis and other educational material, but unlike 

these documents, which often have the goal of being the most complete resource on a topic, 

we explore user contributions within a model of collaborative refinement where the 

objective is not to move towards a single “best” document but rather to elicit and make 

accessible a range of community enhancements. 
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Chapter 3 – System Description 

System Description 

In this chapter, we describe how we approached the problem of eliciting structured tutorial 

enhancements and illustrate our solution through a prototype system called Antorial. When 

describing Antorial, we use the term note rather than comment to shift the emphasis from 

general tutorial-relevant discussions found in comments sections (e.g., words of 

appreciation for the tutorial author, and requests for help on other tasks with the software 

[22]) to contributions that pertain directly to the content of the tutorial in question. 

We start this chapter by describing some of our initial paper prototypes and how they lead 

to our design goals. Briefly, our goals are to elicit content-specific enhancements from 

users, to guide users towards posting useful content and to integrate notes into the tutorial 

as first-class citizens. Using these design goals, we describe how they inspired us to create 
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Antorial. We conclude this chapter with a pilot study we used to confirm the direction of 

the design and to gain some initial insight into the usability of the system. 

3.1. Initial Prototypes 

We explored many different alternatives using paper sketches. We describe some of our 

more developed prototypes here, with their sketches in Figure 1. In general, we wanted to 

somehow include tutorial improvements from the community, while keeping the original 

tutorial intact, allowing readers to learn from multiple perspectives. 

One method we have considered is what we called branching tutorials (Figure 1 (A, B)). 

With branching tutorials, a contributor chooses where in the tutorial they want to make 

modifications, and creates a new branch. A reader will then be able to navigate between 

branches, and choose which path to follow. We have also looked at a simplified version of 

the branching tutorial approach, where only two versions of the tutorial are saved (Figure 

1 (C)); the original tutorial as written by its author and an alternate tutorial, where the 

community has modified the original tutorial. Another approach we have considered is 

having different levels of detail available for a tutorial (Figure 1 (D)). A reader can then 

choose to see the tutorial or individual steps as they are streamlined or expanded by other 

tutorial followers. 

A disadvantage with these approaches is their complexity. A reader might not have time to 

read all versions of a tutorial to find which one is most appropriate to their goal. We also 

felt that tutorial followers might assume that one version of the tutorial would be the best 

overall, something that might not be true. For example, there might be workflows of the 

same quality, but using different techniques; or tutorials differing in software version, so 
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aren’t directly comparable. In addition, conceptually, it might be difficult for contributors 

to map out how their improvements will relate to the existing content.  

After sketching, we compared these alternatives and identified similar properties across 

interfaces. Inspired by these properties, we determined that our final system should support 

the following goals: 

- Eliciting content-specific enhancements: Previous work has found that some 

submissions might be off-topic [22], so we focus on encouraging material relevant 

to the tutorial. 

 

(A) 

 

(B) 

 

(C) 

 

(D) 

Figure 1. Sketches of alternatives that we have explored before implementing Antorial. (A) One possible 

implementation for branching tutorials. Bars to the left of the tutorial present alternate workflows for 

steps next to the bars. The user also has the option to change the tutorial version using buttons at the top. 

(B) An alternate implementation of branching tutorials. When a split occurs, the user can choose which 

branch to follow, in this case, selecting the GIMP path. (C) The user has the option to toggle between the 

original content, and alternate steps created by the community. (D) The user can choose the amount of 

detail to show in a tutorial using the detail slider. 
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- Guiding contributors towards posting beneficial notes: This goal focuses on the 

content quality of user contributions, as on-topic contributions might still be of poor 

usefulness. We can possibly use the interface to guide users towards posting 

potentially beneficial content. 

- Integrating notes as first-class citizens: Finally, we want to emphasize the 

importance of contributions. This might encourage readers to use these 

improvements in their own workflows, or to provide their own. 

3.2. Antorial 

After analyzing the different alternatives and gathering informal feedback on our sketches 

from human-computer interaction specialists, we narrowed down our design to Antorial – 

a system which allows users to categorize their notes, and associate them to a step within a 

tutorial. In addition, users are able to select which notes to view on a category and tutorial 

step basis, hiding the rest. Below we describe Antorial with respect to our design goals. 

3.2.1. Eliciting Content-Specific Enhancements 

Our first goal is to elicit enhancements from users specific to tutorial content. In particular, 

we want to help contributors submit content that might be beneficial to other readers. As 

we previously described, past work has found that there are a variety of comment types 

being submitted to feature-rich software tutorials [22]. For example, we can find comments 

that show appreciation, ask for help, offer suggestions to improve the tutorial, and that offer 

alternate workflows. We make the assumption that not all of these comment types are 

useful when improving tutorials and want our design to increase the overall utility of 



Chapter 3 – System Description  15 

 

comments. The first step we take towards this end is to encourage users to post content 

specific to the tutorial. 

We selected a tutorial step as the scope for a note based on prior work indicating that the 

vast majority of text-and-image tutorials are step-based, most of which have clearly 

labelled steps [27], typically containing a single instruction or related series of small 

instructions that produce a single effect. Prior work has also explored ways to segment 

tutorials according to steps, for example, using crowd workers [20]. Collectively, this 

suggests that a step is both a conceptually meaningful unit within the tutorial community 

and that a tutorial could be segmented into steps either programmatically or via crowd 

annotation. Second, when prototyping more flexible models, as described in the previous 

section, we found that our note elicitation and display interfaces were more complicated. 

Furthermore, work in annotation systems for educational material [37] has found that 

annotations with a greater scope were not as useful. Therefore, we focus on an individual 

step-based model and leave the exploration of more flexible models for future work, as 

described in Chapter 5. 

Figure 2 shows the mechanism of contributing a note for a particular step using Antorial. 

When the user hovers over the step they would like to contribute to, a “submit note” icon 

appears (Figure 2 (B)). Clicking this icon will then automatically select this step for the 

note, and start the note submission process. Steps that have notes tied to them will show 

icons indicating as such (Figure 2 (A)), and a user can click on these icons to view the notes 

below the step. The note submission process and how the visibility of notes are toggled are 

described in greater detail in 3.2.2 and 3.2.3.  
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3.2.2. Guiding Contributors Towards Posting Beneficial Notes 

Through the posting process, we can potentially guide contributors so that they submit 

content aimed at improving the tutorial. In the previous goal, we described how we could 

possibly motivate users to post material relevant to the tutorial’s content. With this goal, 

we request some extra pieces of information tied to notes to further guide posters in 

submitting higher-quality content: we decided to ask users to categorize notes using 

predefined categories.  

Creating our categories was an iterative process. We started with software tutorial comment 

categories identified in previous work [3,22]. However, we found that these categories 

reflected existing commenting behaviour (in free-form systems) and were not intended to 

guide contributors towards enhancing the tutorial’s content. With this different perspective 

in mind, we reviewed comments from over 200 Photoshop tutorials, for a sense of content 

enhancements that were both common and potentially useful. We then grouped these 

comments and formed a hierarchy of comment labels from which we drew our categories. 

 

Figure 2. Step-based notes. An icon (B) starting the note submission process appears to the right of a step 

when the user hovers over it. Once notes are submitted, different icons appear to the left (A); clicking 

them displays notes for that step. 
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We then created a set of icons for the categories, and refined both the icons and categories 

through the pilot study described in Chapter 3.3 as well as through informal feedback (see 

Appendix A for details). The categories are presented after the user has chosen a step on 

which to comment, and once a category is chosen, its description is shown, as illustrated 

by Figure 3. The following are the categories we have used in the evaluation described in 

Chapter 4, and the descriptions that were available to users, while the icons can be found 

in Figure 4:  

- Tell me more!: Information that is not crucial for completing the tutorial, but may 

help someone learn something new. 

- What is this?: Clarification for something that is crucial in completing the tutorial. 

- Corrections: Point out an error in the tutorial, or provide a correction. 

- Questions: Asking a question for the tutorial. Other users may provide a reply. 

 

Figure 3. The user has selected the Tell me more! category, and is entering their note’s content. 

 

Tell me more! 

 

What is this? 

 

Corrections 

 

Questions 

 

Other 

 

 

Add a note 

Figure 4. The set of icons we used is our evaluation. The Add a note icon is used to start the note 

submission process, while the others are used for our note categories. 
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- Other: Label your note with your own category.  

We emphasize that our current set of categories and icons is a starting point for 

investigating the utility of this general approach to note elicitation. Developing a fully 

robust set will likely require a more complete iterative design and evaluation cycle. 

As part of guiding readers towards content refinement, some categories require users to 

provide further detail about their notes. For example, the What is this? note category tries 

to guide the poster towards notes specific to software (as opposed to the workflow), and, 

therefore, contributors are encouraged to provide the software or software version to which 

the note applies. The Other category asks users to provide a label for their note. In future 

iterations, other fields could be added, but it is important to consider the tradeoffs: more 

information could be useful to readers, but how many fields are contributors willing to fill 

before losing patience? 

3.2.3. Integrating Notes as First-Class Citizens 

The concept of community notes being first-class citizens within a tutorial refers to the idea 

of promoting notes, as they could potentially be just as important as the tutorial. In many 

existing commenting systems, comment sections are often relegated to a part of the page 

that is of secondary importance, such as below the tutorial, possibly de-emphasizing their 

role. We explored different note display options, which could help promote their 

importance. 

In displaying the notes, we faced a tension between our goal of promoting notes as first-

class citizens and the possibility of introducing too much clutter in the event of high note 

volume. We could potentially show all notes at once either below or to the side of steps to 
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emphasize their importance, however, we consider the following issues. If the notes are 

placed below the step, the flow of the tutorial is broken, as the user needs to scroll through 

all notes tied to the step to get to the next step. When placed to the side of the tutorial, it 

can become difficult to associate notes to specific steps as there may be too many notes to 

display next to individual steps. 

We ultimately decided on a relatively conservative solution for this initial prototype that 

indicates the presence of notes by display the icons for their categories next to the tutorial 

step (e.g., see Figure 2 (A)), but keeps their content hidden until requested. Clicking on the 

category icons displays the notes directly below the step, as in Figure 5. By displaying 

notes immediately after a step, upon demand, Antorial aims to reinforce the importance of 

contributor notes as complements to the originally authored steps.  

3.2.4. Implementation 

Antorial is implemented as a standalone web application built with the AngularJS 

JavaScript library. The tutorials and user notes are stored within a SQLite database, 

 

Figure 5. By clicking on the icons on the left of the step, the user can see notes submitted to that step. 
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managed via an admin interface implemented in Python, using the Django framework. 

Antorial assumes its tutorials have a step-by-step structure, which, as described above, is 

true for most text-and-image tutorials found online. 

3.3. Pilot Study 

To get some initial feedback prior to conducting a more thorough evaluation, we conducted 

a small in-lab pilot study with five experts in the target software (in this case Photoshop).  

The goal of the pilot study was to gain initial insight into Antorial’s usability and to help 

refine its interface. The five participants (three female, two male) were 21 to 25 years old 

and received $15 CAD as compensation. 

3.3.1. Method 

During the study we asked participants to read through two Photoshop tutorials. For each 

tutorial, we then asked participants to make notes to address three specific issues with the 

tutorial (e.g., to provide further explanation on a specific instruction, to provide 

information on where to find a command, and to make a correction) as well as to make a 

fourth note of their choice. We chose to guide the participants’ contributions in this manner 

to both ensure that all participants would submit something and to exercise a range of our 

prototype’s functionality. 

3.3.2. Results 

In general, Antorial’s approach to note elicitation was well received. Participants did not 

object to the overhead associated with entering notes and saw the potential value in the 

way Antorial organizes the notes for other tutorial followers:  
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I think it’s very easy to use. I would personally love this if I was doing a tutorial. 

(P2) 

I find that very helpful actually. I like that there’s a way to read up notes at 

each step itself. It’s different than going up and down into the comments and 

going back up to the step again. I find that it is also very helpful that there are 

many categories that you can add comments in with. I find that it also makes it 

more useful, like I feel comments you can skip – the comments that are like 

“yeah, thanks for the tutorial” or there are tons of people thanking for it. You 

don't want to read those comments, you can skip through those but here, you 

know that when you open these comments, you’re going to mostly find 

something useful. (P3)  

The pilot study also pointed out issues with icons that we used to represent the categories, 

as well as the categories themselves, which we subsequently refined to our current set. The 

details of these changes can be found in Appendix A. 

3.4. Summary 

In this chapter, we presented some of our initial paper prototypes, which we used to create 

design goals, the system we implemented – Antorial, and a pilot study. We described how 

Antorial fulfills our design goals, as well as how our initial users appreciated the approach 

we have chosen. Following our pilot study, we then proceeded to conduct a multi-session 

evaluation using Antorial, described in the next chapter.
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System Evaluation 

We have previously described the Antorial system and an initial pilot study validating our 

design. We followed this by conducting a more in-depth, multi-session evaluation to 

investigate how Antorial’s model of collaborative tutorial refinement impacts contributions 

as well as to gather subjective impressions of the strengths and weaknesses of the general 

approach. For our tutorials, we chose Photoshop as our target application owing to its 

popularity and to provide us with a wide enough pool of knowledgeable contributors. The 

study was approved by the university’s research ethics board (see Appendix B and 

Appendix C for certificates). 

4.1. Participants 

To increase the probability that our participants would be capable of contributing content 

to tutorials, we chose to recruit expert Photoshop users. In total, fourteen experienced 
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Photoshop users participated in our study, recruited from a local university (see Appendix 

D for the poster advertising the project), from online discussion forums (Reddit), as well 

as through word-of-mouth. We pre-screened participants to ensure that they had enough 

knowledge of Photoshop to contribute to tutorials. Given some of the challenges of eliciting 

self-assessments of expertise with a complex and diverse application like Photoshop (e.g., 

see [3]), we asked participants to either share some of their prior work, and/or answer 

specific questions about some of Photoshop’s features that are used in our chosen tutorials. 

Although evaluating the system with participants with more diverse levels of experience is 

important, we leave this for future work. 

Our call for participation also sought individuals who liked contributing their software 

knowledge, as our goal was to test the impact of Antorial on users who are likely to be 

contributors in the first place. Participants were 18 to 40 years old, and four were female. 

Participants received a $100 CAD gift card of their choice for their participation. 

4.2. Conditions 

Our study had a within-subjects design with two conditions; participants were asked to 

complete and improve two tutorials with each of the following two interfaces: 

1. Antorial: In the Antorial condition, participants used the prototype as described in 

Chapter 3 to enhance tutorials.  

2. Baseline: The baseline condition represented a conventional threaded tutorial 

commenting interface, where users are able to enter free-form contributions. As 

shown in Figure 6, we made one modification to the status quo by placing their 

comments beside the tutorial rather than buried below the tutorial. We did so in an 
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attempt to avoid unfairly biasing the results against a baseline with contributions 

completely deemphasized. 

4.3. Tutorials 

As mentioned above, participants completed and worked on improving four Photoshop 

tutorials (two per condition).  

A professional Photoshop user (a designer) assisted us in hand-picking four tutorials from 

publicly available online sources. To have some variety and to cover a range of Photoshop 

skills, we selected two tutorials that use parameterized commands, such as layer styles (the 

filter tutorials in Table 1), and two that use free-form tools, such as the paintbrush (the free-

 

Figure 6. The baseline interface: submitted comments are to the right of the tutorial, are always visible 

and scroll independently from the tutorial. 

Tutorial Title Steps Type 

How to Create a Futuristic Metal Text Effect in Adobe Photoshop 16 Filter 

Add a Rain Effect to a Photo in Photoshop 14 Filter 

Make a Trendy Double Exposure Effect in Adobe Photoshop 10 Free-Form 

How to Create a Layered Floral Typography Effect in Adobe Photoshop 7 Free-From 

 

Table 1. The four tutorials that participants completed and contributed to in the study. Each participant 

completed one Filter tutorial and one Free-Form tutorial per condition. 
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form tutorials in Table 1). Being mindful of participant time, we compressed the tutorials 

by removing some extraneous steps; in the end, each of the tutorials had a single goal 

described by its title. The tutorials we have used and their original sources can be found in 

Appendix E. 

We paired the tutorials so that participants completed one filter tutorial and one free-form 

tutorial per condition. Our Photoshop expert judged the filter tutorials to be easier, so 

participants always started each pair with a filter tutorial to enable a logical progression of 

difficulty.  

We pre-seeded each tutorial with three comments to give participants some initial sense of 

potential contributions. One of the pre-seeded notes on each tutorial was a question, while 

the other two were either elaborations on a part of the tutorial (Tell me more!) or some 

explanation for a missing detail (What is this?). These notes can be found in Appendix F. 

To ensure that all participants, regardless of when they entered the study, had the same 

opportunities to enhance the tutorials, notes from other participants were not visible during 

the study. 

4.4. Procedure 

We began by asking participants to sign a consent form (Appendix G) and to fill in a 

demographics questionnaire (Appendix H). We then explained our study scenario. To 

motivate participants to contribute, we introduced a small amount of deception (approved 

by the university’s research ethics board). Specifically, we told participants that we were 

considering using four tutorials as part of a course and requested their help in improving 
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them. We also indicated that we were experimenting with different interfaces for their 

contributions. 

Participants were asked to complete the four tutorials remotely, two per condition. To 

provide participants with sufficient time and flexibility to complete and improve each 

tutorial as their schedules dictated, they were allotted three days per tutorial. As a rough 

guideline for expectations, we told participants not to spend more than two hours in total 

on each tutorial. When participants were finished with a tutorial, they contacted the 

researcher to receive access to the next tutorial. To account for potential order effects, we 

counterbalanced the order of conditions across the participants. We assigned tutorial pairs 

to condition in a round-robin fashion. At the end of this first session, we sent a document 

to each participant summarizing the study procedure (Appendix I). 

Prior to each condition, participants received a short document summarizing the main 

features of the system in lieu of a live interface demonstration – see Appendix J for both 

documents. After completing the condition, participants completed a Likert-scale 

questionnaire (Table 3). 

To conclude the study, participants took part in a semi-structured interview (see Appendix 

K for the sample questions) and debriefing session, where we explained the nature of the 

deception.  

For each participant, the study lasted from 2 to 22 days depending on how quickly they 

completed each tutorial, with an average length of 11 days. We estimate the total time 

commitment per participant to be 7-8 hours. 
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4.5. Data Collection and Analysis 

Our study data consisted of participants’ contributions, their responses to the post-

condition questionnaires (see Table 3) and their perspectives on the strengths and 

weaknesses of Antorial’s general approach collected via the semi-structured exit interviews.  

When analyzing the data, we coded participant contributions using an open coding scheme 

that we refined iteratively. We analyzed the interviews – which were transcribed in full – 

thematically through joint sessions among Human-Computer Interaction Lab members, 

with continual revisits to the raw transcripts to help ensure the validity of our identified 

themes. We compared quantitative means using an RM-ANOVA with Interface Type 

(Antorial vs. Baseline) as the within-subjects factor. We also included Interface Order 

(Antorial First vs. Baseline First) as a between-subjects factor to check for potential order 

effects. Finally, we compared distributions for categorical variables using Pearson’s CHI-

squared test. We report results as significant if p < 0.05.  

The post-session interviews revealed that one participant became frustrated by the study’s 

workload in the first condition (the baseline condition), and decided not to keep 

contributing. We removed this participant’s data from our analysis since they did not 

experience both conditions.  

4.6. Contribution Volume and Content 

We begin our results with the amount and content of participants’ contributions. Over the 

course of the study, the 13 participants that we included in our analysis made 319 

contributions: 192 with Antorial compared to 127 with Baseline. Figure 7 (Left) depicts 

the results on a per-participant basis. On average, participants made 14.9 contributions with 
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Antorial (SE = 3.4) compared to 10.0 with Baseline (SE = 2,8), a difference found to be 

significant (F1,11 = 7.32, p = 0.02, η2 = 0.4). This represents an average increase of 49% 

when contributing with Antorial over Baseline. The Interface Type × Interface Order 

interaction effect was not significant (F1,11 = 0.59, p = 0.48, η2 = 0.05).  

To get a sense of whether or not Interface Type impacted how verbose participants’ 

contributions were, we also analyzed the average number of words per contribution. Figure 

7 (Right) shows that participants did write slightly less with Antorial on a per-contribution 

basis (M = 26.53, SE = 3.43) than with Baseline (M = 30.59, SE = 2.7), but this difference 

did not reach significance (F1,11 = 2.61, p = 0.14, η2 = 0.192). The Interface Type × Interface 

Order interaction effect was also not significant (F1,11 = 1.48, p = 0.29, η2 = 0.119).  

In examining contributions, we found that one source of additional verbosity in the baseline 

(where, on average, participants wrote four extra words per contribution) was that 

participants often had to add extra context. For example, 47% of Baseline contributions 

identified some step number, as the following note illustrates:  

  

Figure 7. (Left) mean number of notes per participant; (Right) mean number of words per note. Error bars 

represent standard error. 
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Step 3 - If you want to hide the duplicate layers, you can click on the eye icons 

(on the left side of each layer) to hide them. (P6) 

Step information, on the other hand is built into the notes with Antorial. 

In further analyzing the content of participant contributions, we found that they differed 

along the following primary dimensions: type, intended audience, scope, and whether the 

contribution attempted to provide potentially helpful supplemental information or simply 

critiqued the tutorial. We discuss each dimension in turn below. 

4.6.1. Contribution Type 

We identified seven types of contributions that participants aimed to make: to present an 

alternate workflow or method of command access, to express appreciation, to pose a 

question or mention a difficulty, to correct a portion of the workflow, to correct the wording 

or grammar, to expand an explanation, and to extend the workflow to improve the final 

result. Figure 8 (A) illustrates the distribution of contribution type across the two conditions, 

which were significantly different according to a Pearson’s Chi-Square test (χ2 = 17.772, p 

= 0.007). 

The most common contribution type was to expand upon the explanation provided in the 

tutorial, which accounted for just over a third of the contributions in each condition. In 

examining differences in Antorial’s and Baseline’s distributions for contribution type, 

there appeared to be a tradeoff between workflow corrections – suggestions related to 

tutorial content (e.g. incorrect tool usage), and grammar/wording corrections. Specifically, 

more of Antorial’s contributions offered corrections to the workflow (Antorial: 13%, 

Baseline: 3.7%), while Baseline’s corrections were more focused on the writing quality 
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(Antorial: 1.9%, Baseline: 9.6%). The remaining contribution types were roughly equally 

represented across the two conditions. 

 
(A) Note types (χ2 = 17.772, p = 0.007) 

 
(B) Target audience (χ2 = 0.236, p = 0.889) 

 
(C) Note scopes (χ2 = 6.263, p = 0.180) 

 
(D) Note content (χ2 = 1.023, p = 0.312) 

Figure 8. Graphs illustrating the distribution of comments using different categorization methods, along 

with the results from the Pearson’s Chi-squared tests. 
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4.6.2. Target Audience 

We also found that contributions differed in their intended target audience. Some were 

clearly directed at the tutorial author, whereas others were more directed at potential 

tutorial followers. For example, the note below appears to be addressed to the author. It 

suggests an area within the tutorial where the author can expand, and goes on to describe 

some specific suggestions (omitted for space reasons).  

Maybe add some pointers afterwards to what can be done to take the effect 

further? For those who want to keep experimenting. […] (P8) 

This note, on the other hand, addresses potential readers directly, and even qualifies the 

level of expertise targeted: 

For advanced users: If you convert your layer to a Smart Object before adding 

your filters they become "Smart Filters" that you at any time can double-click 

to adjust the settings. (P8) 

Figure 8 (B) shows that most of the contributions in both interfaces were aimed at the 

tutorial author (Antorial: 78%, Baseline: 78.9%). This is perhaps not surprising considering 

the scenario we described to participants: that we were considering using these tutorials in 

a course and wanted their help to improve them. Additionally, there was no interaction 

between contributors, which may have reduced the incentive to offer advice to other 

tutorial followers. Despite these aspects of the study scenario, some participants did 

continue to view their contributions as a way to communicate with other tutorials followers 

(roughly 9% of contributions in each condition), or worded their contributions in a way 

that they could target either audience (e.g.,13% in Antorial). Overall, Interface Type did 
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not appear to impact the distribution of comments across target audience (χ2 = 0.236, p = 

0.889).  

4.6.3. Contribution Scope 

We found the participants’ contributions had the following scopes: the entire tutorial, 

multiple steps, a single step, a specific word(s), or a new step (Figure 8 (C)). Despite 

Antorial’s explicit step-based elicitation method, the difference in scope distribution across 

the two conditions did not reach significance (χ2 = 6.263, p = 0.180), with the most common 

scope in both conditions being a single step (79% with Antorial and 69% with Baseline). 

This reflects findings with other annotation systems, which found that most notes had 

smaller scopes [37]. Interestingly, participants did write notes with wider scope even with 

Antorial. For example, to address multiple steps, participants would list additional affected 

steps, as they would in Baseline. To recommend an additional step, they would submit a 

note on the step following the location they would place the new step. We return to the 

possibility of explicitly supporting these additional scopes in section 4.8. 

4.6.4. Supplement vs. Critique 

We found that contributions differed in the degree to which they simply pointed out issues 

or actually helped to work towards solutions. A supplemental note provided specific 

directions on ways to improve or correct the workflow, or the tutorial’s explanations. For 

example: 

It is better to explain at this point why you are making some colour and focus 

adjustments to the photo. In this case, the photo has warm tones which is 

associated to bright and sunny, therefore colour adjustment is necessary. (P10) 
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The second type, a critique, did not specify exact ways to enhance the tutorial, but pointed 

out places where the improvement could/should take place: 

You might want to clarify in greater detail how you masked out the dark beige 

portions. It's a crucial component of the tutorial. (P12) 

Figure 8 (D) shows that most contributions were in fact supplemental (74% with Antorial 

and 79% with Baseline). The difference in distribution across the two conditions, however, 

was not significant (χ2 = 1.023, p = 0.312).  

When examining these contributions according to their target audience we found that all 

those targeted at tutorial readers offered potential advice as opposed to simply critiquing. 

We return to the potential role of audience and how systems might further promote reader-

centric enhancements in section 4.8.  

4.6.5. Antorial Categories 

Antorial supplies its own note types (i.e., its categories) in an attempt to guide the tutorial 

notes. Using a strict definition of correctness, we coded an Antorial note as correctly 

categorized if and only if the participant selected the most appropriate category given our 

definitions in Chapter 3.2.2. Using this criteria, we found that most notes (55% – see Table 

2) where not, in fact, categorized as we would have envisioned. As we describe in our next 

Category Correct Incorrect 

Corrections 17 34 

What is this? 17 4 

Tell me more! 38 39 

Questions 9 1 

Other 5 28 

Total 86 106 

Table 2. Number of times participants used Antorial's categories according to their original definitions. 
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section, some participants found the categories straightforward. Others found them 

confusing and/or did not want to expend the effort to categorize their notes. For example, 

one participant (P6) only used the Tell me more! category for all of his 10 notes.  

4.7. Subjective Response 

The post-condition questionnaires showed that participants were generally comfortable and 

motivated to post comments with both interfaces (Table 3), with little difference between 

the two conditions.  

In terms of overall preference, participants’ responses were split: five preferred Antorial, 

five preferred Baseline, and three participants were neutral. In what follows, we discuss 

some important considerations that participants raised during the interviews for systems 

that aim to support collaborative tutorial enhancement. We also describe how these 

considerations influenced participants’ preferences for the two systems investigated.  

4.7.1. Supporting Specificity and Context through Step-Based Notes 

Most participants felt that Antorial’s per-step commenting model was more tailored 

towards eliciting enhancements than the free-form comments in the baseline system. They 

found that the model helped them focus on specific enhancements and reduced the amount 

Statement Antorial Mean (SE) Baseline Mean (SE) F1,11 p η2 

I felt encouraged or 

motivated to post comments 
4.45 (0.19) 4.38 (0.26) 0.31 0.59 0.027 

I felt like it took a lot of 

work to post a new comment 
2.16 (0.33) 1.83 (0.33) 1.19 0.30 0.098 

I felt comfortable posting 

comments 
4.93 (0.08) 4.85 (0.11) 1.19 0.30 0.097 

I felt confident that the 

comments I posted will be 

useful 

4.79 (0.11) 4.85 (0.11) 0.22 0.65 0.020 

Table 3. Post-condition Likert-scale questionnaire results (1 = Strongly Disagree, 5 = Strongly Agree) 
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of additional context they had to provide, supporting our first design goal. The following 

two quotes are representative of these sentiments: 

Then I can focus on the step I'm talking about, if you noticed for the [baseline] 

whenever I made a comment I would say something like “In Step 7, this this 

this.” But for [Antorial] I don't have to do that. Everyone knows this is the step 

we’re talking about. (P3) 

[Antorial] is more specific than [the baseline] […] The [baseline] is just for 

regular stuff, [Antorial] is much more specific. (P1) 

4.7.2. Guiding Contributions through Categories 

Participants’ views on structuring tutorial contributions with pre-defined categories 

diverged. Some participants did not mind specifying categories, as long as it makes it more 

convenient for other people, particularly other contributors: 

For the [contributor], it keeps suggestions and information [more] organized 

[…] In the eyes of the reader, […] it will be easier for the people answering 

[comments and questions]. People have asked and you'll see if they have been 

answered already. You won't have to answer twice because you can find things. 

(P10) 

Several participants also said that specifying a category actually helped them craft their 

notes and understand which contributions would be considered valuable, which was our 

second design goal: 
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[The] icon guided me to make my comments. […] I would go here and say 

‘maybe I need to look for something I don't understand, or something to 

correct.’ (P3) 

Four out of the five participants who preferred the baseline system, however, specifically 

complained about the overhead that the categories introduced. These participants felt that 

the categories were not completely clear, that selecting one required too much thought, 

and/or that they restricted contributions in a way that was not beneficial: 

I knew what my comment was but I really had a hard time figuring out what 

the category should be. I actually looked at the other comments to see what 

other people were saying. Maybe if I could get an idea [from the comments] 

maybe I'd learn, but that wasn't the case. (P11)  

I prefer it when something is more open because it doesn't make a person feel 

like they're restricted by what they should or shouldn't put down […] 

sometimes those [categories] would be in the same comment I was trying to 

make and I think "ok, should I split this up into three?" and I really didn't like 

doing that and would [rather just] put everything there. (P2) 

In relation to P11’s quote above, our study made it difficult for participants to leverage 

community categorization practices, in that we pre-seeded each tutorial with only three 

notes. It’s possible that more notes would help contributors better establish and understand 

norms. 
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Out of the people who saw benefit in specifying categories, not all of them felt that they 

understood the categories provided in Antorial, but were content with their workarounds, 

such as selecting Other when they did not feel that their note fit into a particular category.  

Overall, our sense from the interviews is that the categories could certainly be refined to 

reduce confusion, but the extent to which this would alleviate all of participants’ concerns 

is an open question. Some participants who preferred free-form note entry, simply wanted 

to express their tutorial input and move on.  

4.7.3. Sense of Community vs. Social Cost 

Our interviews also revealed some potentially interesting tradeoffs with having 

contributions permanently visible. In the baseline system, comments were always 

displayed to the right of the tutorial (see Figure 6). With Antorial, users had to click the 

category icons to reveal the notes below a step (see Figure 2). On the one hand, several 

participants indicated that the always-visible comments in the baseline system provided 

them with a better sense of the community. For example, one participant indicated that the 

baseline system suggests an active discussion with other artists: 

More discussion with [the baseline]. It feels more like the commenting section 

- it feels like you'd have more discussion with the other artists than on 

[Antorial]. Um, the replies back and forth with the artists that you'd normally 

get with Reddit, with the tossup of ideas (P9) 

Another participant said that this sense of community gives them confidence that their 

questions might get answered quickly: 
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If I'm going to be asking questions, and I have people respond also, most 

tutorials, you watch them or follow them without having the community to 

support you if you don't understand something. I would feel very happy to have 

such [support]. (P3) 

This notion of promoted user comments providing a sense of community surrounding a 

tutorial has also been identified in prior work [3].  

On the other hand, the visibility of contributions also seemed to make a couple of 

participants concerned with the social cost associated with contributing. For example, one 

participant indicated that they were more conscious of their posting volume in the baseline 

system (where they posted only 5 notes) than in Antorial (where they posted 22 notes). 

With the baseline system, the participant said: 

I didn't want to annoy other people and post a lot. So I combined all the things 

I had to say step by step into one tutorial, by the end of it. (P11) 

This is supported by this participant’s contributions in the baseline, which tended to group 

together multiple brief points, as opposed to in Antorial, where they were more descriptive. 

Exploring how properties of the systems (in addition to contribution visibility) might 

impact these more social aspects of tutorial contributions is an interesting avenue of future 

research. 

4.7.4. Providing Multiple Perspectives as a Motivation to Contribute 

A motivation for Antorial’s model of collaborative tutorial enhancement is that there is 

often no “correct” version of a given workflow. In our interviews, two participants said 

that a desire to provide an alternative perspective motivated them to contribute: 
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… there is not a right or wrong way to paint the sunset, you know, you see it, 

you make your visual translation, and that's your interpretation. And just like 

Photoshop, if you want to achieve an objective there are hundreds of ways to 

do it, so one is not necessarily the right way. There are more efficient ways, 

but nothing is really right or wrong. (P6) 

[The tutorial] may be doing it one way but there might be another way. So I 

don't like giving one method and saying that is the only way, there [are] 

thousand different ways to do something. (P9) 

These quotes lend some initial support for Antorial’s approach to enabling a community of 

tutorial users to contribute multiple perspectives.  

4.7.5. Enabling General Discussions 

Participants suggested that future iterations of Antorial should also explore general 

discussions as a complement to scoped notes. For example, one participant indicated that 

general comments might be more review-style, giving an overview of the tutorial’s 

approach: 

I did notice other individuals who are commenting just commented about the 

tutorial overall, which I thought was interesting. I thought they were 

commenting almost as a review, like “oh this is an interesting way to put rain 

on the photo.” (P11) 

Given that each tutorial was pre-seeded with the same style of note (regardless of 

condition), the fact that this participant viewed some notes in the baseline system as more 

review-oriented is interesting. This is perhaps reflective of the view that commenting 
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sections are generally for expressing opinions. Further investigation, however, on how 

users might perceive comments posted in different areas is needed, as well as how 

providing multiple scopes might influence contribution types and volume. 

4.8. Discussion 

Our evaluation’s results indicate that participants made close to 50% more contributions 

with Antorial’s structured approach than with a baseline commenting system. There is also 

some evidence that Antorial impacted the types of contribution, with a shift in emphasis 

from wording corrections to workflow corrections. The latter type of contribution is 

arguably more beneficial for tutorial readers – adapting to grammar issues is likely easier 

than adapting to errors in the workflow. From the standpoint of community tutorial 

enhancement, it is encouraging that most contributions (both with Antorial and the 

baseline) were aimed at enhancing the tutorial as opposed to merely critiquing without 

suggesting a path forward. Some participants also expressed an explicit interest in 

contributing multiple perspectives. 

4.8.1. Exploring More Flexible Postings Models 

While Antorial’s extra posting overhead did not appear to have a negative impact on either 

contribution rates or contribution content, participants’ preferences for Antorial vs. the 

baseline system were mixed. A central issue appeared to be with Antorial’s categories. 

Some participants felt that the categories served their intended purpose, which was to guide 

contributions. Others, however, found them confusing, unnecessary, and the majority of 

notes were not categorized as we would have envisioned. At a minimum, Antorial’s 

categories need refinement to make them clearer to a wider range of potential contributors. 

Our findings also suggest, however, that it would be worthwhile exploring more flexible 
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contribution models. For example, there may be value in an approach that lets contributors 

easily “opt out” of providing additional structure for their notes. It might also be possible 

to shift the cost vs. benefit tradeoff by incentivizing the process in some way, where only 

categorized notes are integrated into the tutorial as a “reward”, with uncategorized notes 

relegated to a less prominent “general” pool. Moving forward, it will be important to 

understand how differing types and levels of contribution structure impact both 

contributions and the consumption of these contributions by tutorial readers. 

Antorial uses a tutorial’s step as the scope for a note, and our results lend support for this 

design decision: the most common scope across both Antorial and the baseline system was 

an individual step. This is also supported by previous work [37], which found that the 

majority of annotations were anchored to specific content, rather than placed in a general 

discussion area. 

For larger scopes, users found reasonable workarounds in Antorial when submitting notes. 

The range of scopes that we saw in participants’ notes, however, indicates that further 

exploration of more flexible scopes is also warranted. The challenge will be to balance the 

expressive power of such flexibility with the extra overhead and complexity that it might 

introduce. For example, permitting varying degrees of note scope would likely lead to 

contributors having more decisions to make at posting time, and conveying varying levels 

of note scopes within the tutorial might also introduce more visual complexity for those 

seeking to complete the tutorial. 

4.8.2. Considering the Learner and Author Perspectives 

Ideally community tutorial enhancement mechanisms should provide a way for 

contributors to communicate with both the tutorial author and other learners. Our results 
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indicate a mix in intended audience within our participants’ notes. Our results also indicate 

that when contributors addressed other learners they always provided concrete attempts at 

tutorial enhancement rather than critiques. The question then becomes how to reinforce 

this notion of other learners as a potential audience for the contributions. One approach 

could be to acknowledge the roles of contributors, making it clear that learners play a part 

in this acknowledgement. For example, tutorials could include a contributor recognition 

section where learners mark enhancements that they found useful. This could also be 

addressed through the category descriptions, with categories explained in a way that 

emphasizes posting notes to tutorial readers. 

A second, and related, important concern is how a tutorial author might respond to a 

community of users contributing directly to their tutorial, particularly if their contributions 

are prominently recognized. There might be tensions between incorporating these 

enhancements, thereby creating this sense of community, and maintaining control and 

recognition for the final product. We would be interested exploring how different points in 

the design space impact this tension. 

4.9. Summary 

In this chapter, we described a multi-session evaluation comparing Antorial and a baseline 

system. We found that there were more notes submitted using Antorial, and that the 

primary difference in content was in the target of corrections: Antorial’s corrections 

focused on workflow, rather than the baseline’s grammar corrections. We also found that 

Antorial’s features helped users submit focussed content and, that there were different 

perceived social costs between the two interfaces.  Furthermore, our participants felt that 
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our model was fairly rigid, in terms of categories and scope and so further research in 

relaxing these constraints could be beneficial. 
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Chapter 5 – Conclusion 

Conclusion 

Online text-and-image-based tutorials continue to be a source of knowledge for software 

users. Readers often supplement the tutorial’s content using commenting sections [22] and 

prior work has shown that enhancing these sections improves the perception users have of 

the available content [3]. In addition, commenting sections have the benefit of leaving the 

original content intact, providing readers with multiple perspectives of a workflow and 

allowing tutorial authors to maintain ownership [30]. Our goal was to investigate how we 

can elicit such enhancements, while maintaining the aforementioned benefits, and to see 

how the quality and quantity of contributions are affected. 

In this thesis, we described the development and evaluation of Antorial, a system that 

integrated contributions into a tutorial. We conclude by summarizing our contributions, 

and by discussing some limitations and directions for follow-up investigations. 
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5.1. Contributions 

This thesis makes three contributions. The first contribution is a model for community 

tutorial enhancement using structured scoped notes, as illustrated by Antorial. Antorial 

requires users to categorize their notes using one of five pre-defined categories, and to 

select a tutorial step to associate to their note. Notes can then be filtered by future readers 

by selecting the category and steps to see notes of interest. 

We also contribute results from a multi-session evaluation. Our results show a positive 

impact to contributions when participants used Antorial. For example, the average number 

of notes per participant was higher, and participants made more corrections to workflow-

related issues rather than grammar-related, something that is potentially more useful for 

tutorial readers. 

Finally, we contribute some design considerations that can be used in the development of 

further systems supporting community-driven tutorial enhancement. For example, some 

users suggested that having all notes in one place, like with the baseline, promotes a sense 

of community. This might have the effect of encouraging further contributions and 

discussion. However, users expressed concern that they were monopolizing the discussion 

when using the baseline’s single thread of discussion, but not when using Antorial’s 

multiple threads. 

5.2. Limitations and Future Work 

This thesis is a step towards furthering our knowledge on soliciting community 

contributions for online software tutorials. There are many potential avenues for 
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exploration through both study design and system improvements that could lead us to 

additional insight. 

First, there is the issue of the number and representativeness of our participants. Our 

findings are based on 13 participants, all of them expert Photoshop users. Following 

suggestions that the human-computer interaction community should consider resources as 

a factor in assessing the suitability of a sample size [5], we note that this was a resource 

intensive study and the time commitment required from participants – about 7 to 8 hours 

over two weeks – made recruiting difficult. That said, future studies should explore the 

generalizability of the approach to a broader sample of contributors.  

The scenario we introduced in our study may have implicitly limited the types of notes 

submitted by our participants. We told them that we wanted help for improving potential 

course material; this could have influenced our participants to only post notes that they 

thought enhanced the tutorials. Without this requirement, users might feel greater freedom 

to post any type of note they want, and we might see more differences in note content. For 

example, since our participants were all Photoshop experts, we might not have seen as 

many questions as we might in a more realistic setting. An alternative study set up would 

be to release the system to a community of users, and ask them to use it. 

Furthermore, we did not allow participants to have discussions with each other during our 

evaluation, something that other evaluations of annotation systems have emphasized 

[35,37]. Interestingly, some of our study participants were interested in interacting and 

collaborating with each other (as described in Chapter 4.7.3), despite the fact that our study 

design was not conducive to discussions. It appears that this format for user contributions 

does not discourage discussions, but further work is needed to see if there are benefits to 
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encouraging this interaction on software tutorials, and what kinds of discussions would 

occur. In addition, as we increase the number of users and contributions, appropriate 

moderation strategies, both author-centric and community-centric ones, may also need to 

be investigated and included. 

In this thesis, we focused on soliciting enhancements to text-and-image-based software 

tutorials. There remain questions in how to generalize our work to other tutorial formats 

and domains. For example, video tutorials are also a popular tutorial format. There has 

been some work on eliciting corrections to learning videos [9], but as far we know, not on 

soliciting other types of content. Soliciting community enhancements that could be readily 

integrated within a video represents an interesting design challenge for future work; steps 

within a video tutorial may not be as clearly defined as in text-and-image tutorials, and 

note placement and visibility may be more challenging.  

There is also the question of the type of tutorial. While our study targeted Photoshop 

tutorials, there is hope that the approach would generalize well to a range of other types of 

step-based tutorials. Extending this work to different software could be relatively 

straightforward, but generalizing to non-software tutorials could pose a more difficult 

challenge. For example, our categories were decided upon based on comments submitted 

to software tutorials, and may not fit other domains. It is also possible that other tutorial 

topics might not have clear steps to annotate, like we assume for this thesis. 

Another area of future work is the notes’ content and format, such as submitting videos 

instead of text notes. For example, there exists work that augment video tutorials by 

integrating user-submitted videos [23]. Closer to annotation systems, there are other 

examples such as allowing users to submit notes to course material stored as gestures or 
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voice recordings [35]. Simpler media types such as image or rich text formats are also 

possibilities for exploration. How all of these can easily be submitted by contributors and 

how readers can benefit from them are open questions.
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Appendix A – Evolution of Note Categories and Icons 

Evolution of Note Categories and Icons 
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Set 1: We started by sketching icons inspired by those available through icon libraries 

(icomoon.io, thenounproject.com). Informally, we asked Human-Computer Interaction 

Lab members to vote for the icons that they felt best represented their function to get set 2. 

Note that for Other and questions, we did not have sketches, and that this category came 

later. Here is how we defined the categories that have since been modified: 

- Additional detail: Any information that might help someone appreciate the tutorial, 

that does not fit in other categories. 

- Alternate method: Any alternate methods to accomplish the same result. 

- Command location: Information on how to access or execute commands. 

Set 2: We implemented our first prototype, and used these icons and categories for our pilot study.  

Set 3: We gathered feedback from our participants from our pilot study and made the following 

changes: 

- Additional detail was renamed to Tell me more!, as the former was seen to be too 

general. We also narrowed the scope to this category. 

- The Alternate method and Command location categories were merged into the 

What is this? category. Our participants thought that you would automatically 

have command locations when describing alternate methods, and that describing 

how to access commands using different parts of the interface (e.g. keyboard 

shortcuts, menus) was one example of alternate methods. 

Set 4: We decided to split the Other and questions category into the Questions and Other  

categories. As the What is this? icon was more appropriate for Questions, we found a new 

icon for What is this?. This was the set we used in our evaluation and that we refer to in 

Chapter 3.  
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Research Ethics Board Approval 
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Appendix C – TCPS 2: CORE Certificate 

TCPS 2: CORE Certificate 
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Appendix D – Poster Advertising the Study 

Poster Advertising the Study 
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Appendix E – Tutorials used in Evaluation with Sources to Originals 

Tutorials used in Evaluation with Sources to Originals
How to Create a Futuristic Metal Text Effect 

in Adobe Photoshop 
(EnvatoTuts+: https://design.tutsplus.com/tutorials/cms-

25829) 

 

In this quick tutorial, we are going to create a simple Layer 

Style text effect. So you'll be just a couple of layer styles 

to create a bright, futuristic-themed text effect. Let's get 

started! 

 
Step 1 

Create a new 800 x 600px document, fill the Background 

layer with the color #252525. 

 
Step 2 

Create the text. The Color is #a2a2a2. I used the font 

Copperplate Gothic Light with Size 180pt, but this can be 

up to you. 

 
Step 3 

Duplicate the text layer, change the copy's Fill value to 0, 

and then duplicate the copy. 

 
Step 4 

Double click the original text layer to apply the following 

layer style. Add a Bevel and Emboss with these settings: 

Size: 18, Uncheck the Use Global Light box, Angle: 59, 

Altitude: 58, Check the Anti-aliased box. 

 
Step 5 

Add an Inner Shadow with these settings: Blend Mode: 

Linear Burn, Color: #585858, Opacity: 35%, Distance: 0, 

Size: 7 

 
Step 6 

Add an Inner Glow with these settings: Blend Mode: 

Vivid Light, Opacity: 100%, Color: #a39a7b, Source: 

Center, Size: 29 
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Step 7 

Add a Satin style with these settings: Blend Mode: Hard 

Light, Color: #d0d0d0, Distance: 5, Size: 8, Check the 

Anti-aliased box, Check the Invert box 

 
Step 8 

Add a Gradient Overlay with these settings: Blend Mode: 

Multiply, Opacity: 35%, Scale: 150%. Use the default 

Violet, Orange gradient fill. 

 
Step 9 

Add a Drop Shadow with these settings: Opacity: 50%, 

Distance: 10, Size: 10 

 
Step 10 

This will style the original text layer. 

 

Step 11 

Double click the first copy text layer to apply the 

following layer style. Add an Inner Shadow with these 

settings: Blend Mode: Linear Burn, Color: #585858, 

Opacity: 80%, Distance: 0, Size: 13 

 
Step 12 

Add a Gradient Overlay with these settings: Blend Mode: 

Soft Light. Use the following gradient fill: 0% opacity at 

location 0%, 100% opacity at location 100%, black at 

location 51%, white at location 52%. 

 
Step 13 

This will style the first copy text layer. 

 
Step 14 

Double click the second copy text layer to apply the 

following layer style. Add a Bevel and Emboss with these 

settings: Style: Stroke Emboss, Size: 2, Uncheck the Use 

Global Light box, Angle: 119, Altitude: 37, Gloss 

Contour: Ring - Double, Check the Anti-aliased box, 

Highlight Mode: vivid Light 
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Step 15 

Add a Contour with these settings: Contour: Rolling Slope 

- Descending, Check the Anti-aliased box 

 
Step 16 

Add a Stroke with these settings: Size: 3, Position: Center, 

Fill Type: Gradient. Use the following gradient fill: color 

#96723b at positions 0% and 100% and color #fbc110 at 

position 40%. 

 
Congratulations! You're Done! 

In this tutorial, we created three text layers, and styled 

each one of them to create the text effect and the stroke. 

 
 

Add a Rain Effect to a Photo in Photoshop 
(PhotoshopStar: http://www.photoshopstar.com/photo-

effects/rain-effect-photo-photoshop/) 

 

In this Photoshop tutorial you will learn how to add a rain 

effect to a photo. We’ll use blending modes and a couple 

of native Photoshop filters. 

 
 

 

Step 1 

Open the file “Girl”. We’re going to be adding rain to this 

photo but first we’ll make some color adjustments and add 

some focus. 

 
Step 2 

Let’s bring back the bright tones in this photo. Create a 

Curves Adjustment Layer (Layer >New Adjustment 

Layer > Curves) and drag the curve down as shown below. 

You’ll notice a strong darkening effect. 

 
Step 3 

Now let’s hide this darkening effect in the middle of the 

photo. Choose the standard round soft brush and paint 

with 50% opacity over the middle of the photo to partially 

hide the darkening effect there. 

 
Step 4 

We tend to associate rainy or cold days with cold tones – 

however our photo has warm tones. Let’s adjust this by 

creating a Curves Adjustment Layer. Drag the blue curve 

up to boost the blues and drag the red curve down just a 

little bit to get rid of some of those reds. You should have 

something like the results below. 
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Step 5 

Let’s create the rain drops. Create a new layer (Ctrl + Shift 

+ Alt +N) and fill it with black (press D then press Alt + 

Backspace). Now apply some noise by going to Filter > 

Noise > Add Noise. From the options choose Gaussian 

and Monochromatic. 

 
Step 6 

The noise is way too detailed and pixelated for our 

purpose of creating rain drops. Let’s soften it up a bit by 

applying some Gaussian Blur. 

 
Step 7 

Our potential rain drops are just too many and their 

contrast compared to the background is too low. Let’s fix 

this by applying a curves adjustment to the noise layer 

(Image > Adjustments > Curves) with the settings shown 

below. By dragging the arrows towards the middle we will 

boost the existing white drops and get rid of the small 

ones. 

 
Step 8 

And now let’s create the actual falling rain drops. In order 

to do that let’s apply a Motion Blur to our noise layer by 

going to Filter > Blur > Motion Blur. Use the settings 

shown below and make sure to choose an oblique angle – 

rain drops don’t just drop vertically from the sky, they 

come at a certain angle depending on the wind. 

 
Step 9 

Well, we have our rain but as far as we can see there are 

just white rain drops on a black background with no trace 

of our previous scene. How shall we correct that? With 

the help of the blending mode, of course. Simply change 

the blending mode of the rain drops layer from Normal To 

Screen and you’ll see that the black background simply 

disappears leaving only the rain drops visible. 

 
Step 10 

We have added rain drops but the atmosphere looks way 

too clear for a rainy day. Let’s add a bit of fog. Create a 

new layer (Ctrl + Shift + Alt + N) and create some clouds 

by going to Filter > Render > Clouds. 

 
Step 11 

We do have both black clouds and white clouds but we 

don’t need the black ones. How are we going to hide them, 

huh? Well, if you remember in Step 9 we used the Screen 

blending mode to hide the black background from the rain 

drops layer. Will it work for the clouds too? Try it for 

yourself. Change the blending mode of the clouds layer to 

Screen and watch the black clouds vanishing. Because the 

cloud effect is too strong lower the opacity of the layer to 

19%. 
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Step 12 

The clouds are looking good but let’s prevent them from 

covering our main character – the girl with the umbrella. 

Add a layer mask to the clouds layer by going to Layer > 

New Layer Mask > Reveal All. You will see a white 

thumbnail appearing next to the preview thumbnail in the 

layer palette. Click on it to make it active and paint with 

the standard soft brush with black over the center of the 

image. 

 
Step 13 

We’re almost there. Let’s sharpen our image a bit. Create 

a new layer from all the visible layers by pressing Ctrl + 

Shift + Alt + E. Add a sharpen effect by going to Filter > 

Sharpen > Unsharp Mask and using the settings shown 

below to slightly sharpen our scene. 

 
Step 14 

Let’s add some contrast and rich tones to our scene. Create 

a new layer from all the visible layers again by pressing 

Ctrl + Shift + Alt + E and change the blending mode to 

Soft Light. Apply a 20px Gaussian Blur (Filter > Blur > 

Gaussian Blur) and press Ok. 

 

And We're Done! 

In this tutorial, we used blending modes and a couple of 

filters to add a rain effect to a photo. 

 
 

Make a Trendy Double Exposure Effect in 

Adobe Photoshop 
(EnvatoTuts+: https://design.tutsplus.com/tutorials/cms-

23774) 

 

You’ve probably seen this interesting effect of two or 

more overlapping photos on the covers of music albums, 

in modern magazines and in advertisements. In this 

tutorial we’ll create a trendy double exposure effect in 

Adobe Photoshop with the help of Blending Modes and 

Clipping Masks in a few steps. 

 
Step 1 

For the base of our image, we’ll be using the following 

photo of a young man. You can use any photo to your 

liking, for example, from your personal archive. However, 

make sure that the background of your photo is more or 

less neutral, without noisy elements such as grass or 

foliage, to make it easier to work with. 

 
Step 2 

Now we need to get rid of the background. This is a piece 

of cake, as we’re using a photo with a clean background. 

Take the Magic Wand Tool (W) and click anywhere on 

the background to select it. Then go to Select > Inverse in 

order to make the man selected. 
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Step 3 

While you are still armed with the Magic Wand Tool (W), 

find the Refine Edge button in the control panel above to 

reveal the Refine Edge options window. Slightly increase 

the Radius value in the Edge Detection, setting it to 1.5, 

making the edges less rigid and thus revealing minor 

details, such as separate hairs. Set the Output To in the 

Output section of the options window to New Layer with 

Layer Mask. 

 
Step 4 

Create a New Layer below the cut-out portrait and fill it 

with neutral greyish color (#dcdbd9) using the Paint 

Bucket Tool (G). 

 
Step 5 

Let’s select the second photo for our composition. This 

can be some nice flower shot or cityscape, or anything 

abstract and intricate. For this tutorial, we’ll use this 

monochromatic nature scene of a forest. 

 
Step 6 

Place the image of the forest above the man’s portrait. 

Keeping the forest layer selected, press the Control key 

and click on the Layer Clipping Mask of the layer below 

(the one with the portrait). You will see the marching ants 

selection of the man’s silhouette on the forest layer. 

 
Step 7 

Press the Add vector mask button in the bottom of the 

Layers panel to hide the unneeded parts of the forest 

image. Click on the chain icon between the image 

thumbnail and the mask thumbnail in the Layers panel. 

Let’s put the forest image upside down, so that the dark 

reflection of the trees is placed in the head area of the 

silhouette, as shown in the screenshot below. 

 
Step 8 

Select the layer which contains the cutout portrait with 

Clipping mask. Make a copy and drag and drop it above 

the forest layer. Let’s make the portrait monochromatic to 

fit the forest image color palette. Keeping the portrait 

layer selected, move to Image > Adjustments > 

Desaturate, converting our image to grayscale. 

 
Step 9 

Open the Levels (Control-L) options window and make 

the image much darker by moving the black slider to the 

right side or manually setting its value to 117. Apply the 

effect and go to Image > Adjustments > Hue/Saturation. 

Tick the Colorize checkbox in the bottom right corner of 

the options window to change the whole range of colors 

of our image. Set the Hue value to 212, moving the slider 

to the right, thus adding tints of blue. Set the Saturation 

level to 10, decreasing the vividness of the photo, and 

click OK to apply the created effect. 
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Step 10 

Right-click on the portrait layer mask and we can Apply 

Layer Mask in the dropdown menu. Change the Blending 

Mode of the portrait layer to Screen in the Layers panel. 

We see that the desired double exposure effect appears! 

 
Great Job! Our Trendy Portrait Is Finished! 

Congratulations! These simple steps helped us to create a 

stylish double exposure portrait by combining two images 

and creating an interesting surrealistic effect. You can 

then clean up your portrait. Here, I painted some black on 

the landscape mask to hide some of the sky, and painted 

some dark blue on a new layer below the monochrome 

picture to clean the guy's face. From here, it's up to you! 

 
 

How to Create a Layered Floral Typography 

Text Effect in Adobe Photoshop 
(EnvatoTuts+: https://design.tutsplus.com/tutorials/cms-

26315) 

 

Floral typography is a design trend that combines nice 

floral elements with bold typography, to create some 

elegant designs. This tutorial will show you how to use a 

flower stock image, with a simple text, to create a starting 

point for your own floral typography design. Let's get 

started! 

 
The following image was used during the production of 

this tutorial. The cool thing about the technique used in 

this tutorial is that it can work for almost any image you 

use. High-quality images with slightly large details, 

however, can create better and neater results. 

 
Step 1 

Open the image of the flowers and rename its layer 

Flowers. 

 
Step 2 

Duplicate the Flowers layer, and then click the Add layer 

mask icon at the bottom of the Layers panel. Make sure 

that the layer mask thumbnail is selected, and fill it with 

Black. 

 
Step 3 

Create the text in White. You can actually use any font 

and font size you like, but bigger sizes and bolder fonts 

look better. The Font used here is Gill Sans Ultra Bold and 

the Size is 500pt. If you want to place the letters 

separately, create each of them in a separate layer, and 

position them all over the flowers image you have. 
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Step 4 

Group the text layers you have, and call the group Text. 

Then place that group between the two Flowers layers. 

 
Step 5 

Lower the Opacity of the Text group to a value that 

enables you to see both the text and the background image 

details clearly. 

 
Step 6 

Pick the Brush Tool (B), set the Foreground Color to 

White, and pick a hard round brush tip. Click the Flowers 

copy layer mask's thumbnail to select it, and then start 

painting over the parts you want to have in front of the 

text. You can use the [ and ] keys to increase or decrease 

the brush tip size. Just take your time to paint those parts 

as precisely as possible. 

 
Step 7 

If there are any parts that you want to unpaint, you just 

need to set the Foreground Color to Black and unpaint 

those areas. Use the X key to switch between the 

Foreground and Background (Black and White) colors. 

You can also use selection tools to select the parts you 

want to paint in and out if you like. 

 
Congratulations! You're Done 

Once you're done, set the Text group's Opacity to 100% 

again, and check how everything looks to see if you like 

it. Zoom in to fix any areas that need more work. It is a 

slightly time-consuming process, but it is important to get 

a polished final result. 
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Appendix F – Pre-Seeded Notes 

Pre-Seeded Notes 
Tutorial Order Step Selected Category Author Content 

Add a Rain 

Effect to a 

Photo in 

Photoshop 

1 Step 12 Tell me more! Assiniboine 

What part of the fog you erase will 

change every time. A good place to 

clean up is the foreground, in this case, 

the person. 

2 Step 11 Question Winnipeg 
The clouds don't look nice at all, what 

can I do to make them look nice? 

3 Step 8 Tell me more! Assiniboine 

The rain might be hard to see at this 

point, but it will look nice towards the 

end of the tutorial. 

How to 

Create a 

Futuristic 

Metal Text 

Effect in 

Adobe 

Photoshop 

1 Step 8 Tell me more! Assiniboine 

I didn't realize how big of an impact 

having a gradient makes for helping it 

look like metal. 

2 Step 10 Question Winnipeg 
What makes the text look like it's 

above the background? 

3 

Reply to 

note 2 

Step 10 What is this? Assiniboine 

The shadow (layers>layer style>drop 

shadow) makes the text stand above 

the background and the gradients give 

it the 3D look. 

How to 

Create a 

Layered 

Floral 

Typography 

Effect in 

Adobe 

Photoshop 

1 Step 3 Tell me more! Assiniboine This looks better with a thicker font. 

2 Step 6 What is this? Assiniboine 

If you want to unpaint a petal change 

your brush color to black and paint 

over it. 

3 Step 7 Question Winnipeg 
Is there a tool that might make 

selecting the flowers more efficient? 

Make a 

Trendy 

Double 

Exposure 

Effect in 

Adobe 

Photoshop 

1 Introduction Question Winnipeg 
How would I decolor and change the 

overall hue of the image? 

2 Step 3 What is this? Assiniboine 
You can play with the refine edge tool 

to make the outline smoother. 

3 Conclusion Tell me more! Assiniboine 

To expand on what the author's done, 

add a layer between the landscape and 

the face. Then, paint some blue (use 

the eyedropper on the trees) to hide 

some of the landscape. 
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Appendix G – Consent Form 

Consent Form 
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Appendix H – Demographics Questionnaire 

Demographics Questionnaire 
1. What is your pseudonym? This is the name the researcher gave you to use for this study. 

__________________________________________________________________________________ 

2. What is your age group? 

18-20  21-25  26-35  36-40  41-50  >50 

3. What is your gender? 

Male  Female  Non-binary 

4. What is your occupation and/or area of study? 

___________________________________________________________________________

___________________________________________________________________________ 

5. Approximately how often do you use Photoshop? E.g. everyday, once a week  

___________________________________________________________________________  

 

6. For what kind of tasks do you use Photoshop? E.g. website mockups, retouching photos, 

graphic design 

___________________________________________________________________________

___________________________________________________________________________ 

7. How did you learn of this project (E.g. received email from researcher, saw poster on a 

board, heard from a friend)? 

___________________________________________________________________________

___________________________________________________________________________ 
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Appendix I – Study Summary Given to Participants 

Study Summary Given to Participants 
Pseudonym: Assiniboine 

URL: http://redbird.cs.umanitoba.ca/tutorial/ 

Patrick’s email address: patrick.marcel.dubois@gmail.com 

Instructions 
1. Go to the above URL. 

2. Put in your pseudonym, exactly as given to you. 

a. If the page is then blank, then something went wrong. Try refreshing, and make sure the 

pseudonym is spelled properly. 

3. You will be shown a tutorial. 

4. Take your time to contribute to the tutorial. 

5. Email Patrick when you think you are done with a tutorial. 

6. Wait for Patrick to reply and restart at step 1. 

 

Tutorial Information 
 There will be 4 tutorials. 

 It should take 15-30 minutes for a student learning Photoshop to complete a tutorial. 

 Put in 1-2 hours of effort per tutorial to improve them. 

 You will have 3 days for each tutorial. Email Patrick if you think this will be an issue. 

 Email Patrick when you think you are done with a tutorial. 

 You only see one tutorial at a time, and won’t be able to go back to a previous tutorial. 

 

Known Issues 
The system is new and has some issues. Here are those that we are aware of and solutions. If you notice 

anything else, please let Patrick know. 

 The system was tested in Chrome and may not work properly in other browsers. 

 When replying to someone else, your text might not be shown properly. It is only a visual bug. It 

should fix itself when you refresh the page. Please do so to make sure it has been submitted 

properly. 

  

http://redbird.cs.umanitoba.ca/tutorial/
mailto:patrick.marcel.dubois@gmail.com
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Appendix J – System Instructions 

System Instructions 

Interface with Inline Notes 
When you log into the system, you will only see the tutorial. If notes have been submitted, they will be 

visible as little icons to the left of each step of the tutorial. Each icon represents a category. Click on it to 

see notes for that step. When you hover over a step, you will see a button for submitting your own 

notes. 

 

There are 5 categories. 

 Correction: Point out an error in the tutorial, or provide a correction. 

 What is this: Clarification for something that is crucial in completing the tutorial. 

 Tell me more: Information that is not crucial for completing the tutorial, but may help someone 

learn something new. 

 Question: Asking a question for the tutorial. Other users may provide a reply. 

 Other: Label your note with your own category. 

 

Note: When submitting notes to the very first part of the tutorial, they might not be visible until you 

refresh the page. 

 

 

Interface with Sidebar 
When you log into the system, you will see the tutorial with a bar on the side, containing comments. The 

comments submission area is at the bottom of this bar. This bar moves independently from the tutorial, 

so you will have to be aware of where you are scrolling. 
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Appendix K – Semi-Structured Interview Sample Questions 

Semi-Structured Interview Sample Questions 

1. Which interface did you prefer? 

 

2. What did you like/dislike about the interfaces? 

 

3. How did you feel about the categories? 

 

4. How did you feel about placing notes at specific part of the tutorials? 

 

5. What do you think is missing? (sketch on paper) 

 

6. Imagine you are someone learning Photoshop. How do you think you would feel if you 

were using the interface? 


